
HD DVB-T receiver/recorder

Alpha HD

www.evolveo.com

HD DVB-T recorder



HD DVB-T recorder
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Remote sensorUSB port

Power button

AC MainsCoaxial Digital Audio

TV aerial 
for an external TV aerial 

RF Loop through 
for an external device

HDMI Output

TV Scart 
for connection to the TV

Down Mix Audio
2 Channel L/R
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INTRODUCTION

STANDBY
INFO SUBTITLE

OK
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AUDIOUSB TV/RADIO
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26

1

2

3

4

5

6

15

18

19

12

20

21

22

7

8

9

10

11

13

14

16

17

23

24

26

25

OK button
(Confirm a selection within a menu)

Numeric entry
(Enter numeric values and select the channel 
directly by entering it's number)

AUDIO
(Select audio mode and audio track) 

SUBTITLE (On/Off Subtitle) 

TTX  (Open interactive service)
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BACK
(Switch to previous channel)

EPG
(Open up Electronic Program Guide Menu) 

STANDBY
(switch the STB on and standby)

INFO
(Press for current channel information/
Operation guide )

PLAY

Cursor/CH+, -/VOL+,-
(Cursor: Navigation buttons used to navigate
menu's items)
(CH+/-: Channel Up and Down)
(VOL+/-: Volume Up and Down)

RECORD
(Record the TV program)

Search backward /forward

FAV
(Open the Favorite list)

RED/GREEN/YELLOW/BLUE Buttons
(For interactive function/Submenu 
 function buttons)

PAUSE(Pause/Active TimeShift function)

Previous/Next

STOP
(Stop program playback or recording)

TV/RADIO
(Switch between TV and Radio)

MUTE (Turn off/on the volume)

MEDIA
(Enter Recorder menu)

USB
(Enter File Manager)

TIMER
(Timer wake-up)

Menu
(Open and close the menu screen)

EXIT (Exit from menu)

RES



RF OUT RF IN COAXIAL HDMI TV SCART L/R LINE
OUT

220-240V~ 50/60Hz

5V   50mA

RF OUT RF IN COAXIAL HDMI TV SCART L/R LINE
OUT

220-240V~ 50/60Hz

5V   50mA

SYSTEM CONNECTION

There are many different types of TV and other equipment that you can connect to the settop box
In this manual you will see some of the most common ways to connect your equipment.

General

Connecting a HiFi system

Connecting the TV
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RF cable

HDMI cable

Coaxial cable
HiFi

Antenna

SCART cable



Welcome

If you use the STB for the first time, the "Welcome" menu appears.

Press cursor button to setup the Region, Language, Display Mode 

and Aspect Mode.

Highlight "OK" and press the "OK" button to start channel search.

GETTING STARTED

Installation

Select " Channel Scan", press the "OK" button to enter the 
Channel Scan menu. 
Press cursor button to set Scan mode, Scan Band ,Channel No., 
Frequency and Bandwidth,  then highlight "Search", press "OK" 
button to start channel scan . 
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Press the cursor button to set "FTA Only", then highlight "Search", 
press the "OK" button to start auto scan .

1

2

3
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Welcome

Region
Language

Display Mode
Aspect Mode

Czech
English

720p@50HZ
4:3LB

OK

Auto Scan

Channel Scan

LCN

Press the "MENU" button to enter main menu.

Press "UP"or " DOWN " button to highlight "Installation", press 

"RIGHT" button to enter the Installation menu.

Press "UP" or "DOWN" cursor button to highlight the desired item 

and press "OK"button to enter the sub-menu .

Press "EXIT" button to exit.

Select the "Auto Scan", press "OK" button to enter the Auto Scan menu.

If  LCN( Logical Channel Number) Select function is activated, you can't change the original 
number of TV channels by scanning . 
You can activate/disactivate the LCN function by setting the "LCN " to on/off.

Channel Scan
Auto Scan
LCN

Installation

Auto Scan

FTA Only
Search

No

Channel Scan

Scan Mode
Scan Band
Ch No.
Frequency
Bandwidth
Search

By channel
UHF

CH37(666000KHz)
666000KHz

8MHz 

Signal Intensity
Signal Quality

81%
97%



Accessing the Electronic Program Guide (EPG)

OPERATION

Changing Channels 

There are three ways of channel selection - stepping through the channel list, selection by number 
and from the on-screen channel list.

Stepping through the channel list:
            To move through the channel list, press the upward  arrow or downward arrow key on the 
            remote control.

Selected by number: 
            Enter the channel number directly by pressing numeric buttons ,and press the "OK" button 
            to select desired channel.
               Selected by on-screen channels list:
            You can also select the required channel directly from on-screen channel list. This is 
            displayed using the STB's main menu. See "Edit Channel" in this manual for operation detail.
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Accessing the EPG of all channels: 
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2

3

Press "EPG" button to enter EPG menu .

Press cursor button to switch between channel list, events 
schedule of the selected channel and now/next events.

Press "Green" button to Timer the events.

Press "Red" button to display " Time Bar" menu.4
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0008
0009
0010
0011
0012

Interecon
BBC Parl
BBC FO
CBeebie
301

0010 BBC FOUR

The Recor
Auntie's War on Smut
This is CBeebies!

The RecorCommons Questions
Proms on FOUR

Auntie's War on Smut
01:30-02-30

TimerTime

EPG

3/19 01:30 02:00 02:30 03:00

01:39   xx/xx/xxxx



Edit Channel menu 

EDIT CHANNEL

TV Channel list

In the Edit Channel menu, select "TV Channel List", press "OK" 
button to enter TV channel list menu.
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Use this menu to favor, lock, skip, move, sort, delete and  rename 
channel.

Press "FAV" button, then press "OK" button to edit the FAV 
function.

Press "UP" or "DOWN"  button  to highlight channel, press the "OK" 
button to preview the desired TV channel. 
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4
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Press the "MENU" button to enter main menu.

Press "UP" or "DOWN " button to highlight "Edit Channel", press 

"RIGHT" button to enter the Edit Channel menu.

Press "UP" or "DOWN" cursor button  to highlight the desired item 

and press "OK" button to enter the sub-menu .

Press "EXIT" button to exit.

Sort

YooPlay Ga
xxxxxxxx
xxxxxx
xxxx
xxx

TV Channel List

FAV Lock Skip Move Edit

All TV

0001 No Name
0002 YooPlay Ga
0003 E4+1
0004 UKTV Histor
0005 SKY THREE
0006 Sky Spts Ne
0007 Sky News

0001 No Name
0002 YooPlay Ga
0003 E4+1
0004 UKTV Histor
0005 SKY THREE
0006 Sky Spts Ne
0007 Sky News

i

Radio Channel list 

In the Edit Channel menu, select "Radio Channel List", press "OK" button to enter the Radio 
Channel list menu.
Press "UP" or "DOWN" button to highlight channel press the "OK" button to listen the desired Radio 
channel. 

1
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NOTE:             Basically, the operation of "Radio Channel List" is the same as "TV Channel List", 
but there is one point  different: In "Radio Channel List" mode, there is no video 
information, so it will always display Radio's logo in the right side preview window.

Delete All

1

2

Warning! Do you really want to delete 
all channels?

Yes No

Press "color" button, then press "OK" button to edit the 
corresponding function.

TV Channel List
Radio Channel List
Delete All

Edit Channel

Rename Delete

YooPlay Ga
xxxxxxxx
xxxxxx
xxxx
xxx

Edit Channel

All TV

i

A warning window appears.
Select "Yes", press "OK" button to delete all channels.
Select "No", Press "OK" button to cancel deleting.

In the Edit Channel menu, select "Delete All", press "OK" button.
You are asked to input a password(the default password is"0000").



System setup menu 

System setup menu allows us to set Language, TV System, Local Time 
Setting, Timer Setting, Parental Lock, OSD Setting, Favorite, Auto 
Description Setting, Multiview Setting and  Other.

Language 

This menu allows you to set  Language.

SYSTEM SETUP

TV System

This menu allows us to set Video Resolution, Aspect Mode, 
Video Out and Digital Audio Out.

Local Time Setting

This menu allows you to set the region and time.

GMT Usage:  This menu is used  for  open the usage of GMT. 
The options are : By Region/User Define/Off 

GMT Offset:  This menu  is valid only when selected "User Define" 
in GMT Usage menu . 
The GMT offset range is "-11:30 ~ +12:00", increasing 
half hour progressively.

Date:

Time:

"Date" and "Time" menus are  valid only when selected "Off" in GMT Usage menu.

Press numeric button to input the time.

Region:  This menu is used for changing the region setting.

Aspect Mode:  Auto/4:3PS/4:3LB/16:9

Video Out:  

Digital Audio Out:  

SCART CVBS+ HDMI/ SCART RGB

Video Resolution:

LPCM Out/ BS Out
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Video Resolution
Aspect Mode
Video Out
Digital Audio Out

720p@50Hz
4:3LB

SCART RGB
LPCM Out

TV System

4
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2

3

Press the "MENU" button to enter main menu.
Press "UP" or "DOWN" button to highlight "System Setup", 
press "RIGHT" button to enter the System Setup menu.
Press "UP" or "DOWN" cursor button  to highlight the desired 
item and press "OK" button to enter the sub-menu.
Press "EXIT" button to exit.

Language
First Audio
Second Audio
Subtitle Language 
Teletext 
Subtitle

English 
English
German
English 
English 

On

Language

System Setup

Language
TV System
Local Time Setting
Timer Setting
Parental Lock
OSD Setting
Favorite
Auto Description Setting
Multiview Setting 
Other

Region
GMT Usage
GMT Offset
Summer Time
Date
Time

Czech
By Region
GMT+01:00

Off
xxxx/xx/xx

01:51

Local Time Setting 

xxxx,xxx,xxxx

Summer Time: The options  are: On/Off 

By Source/By Native/480i/480p/576i/576p/
720p@50Hz/720p@60Hz/1080i@50Hz/
1080i@60Hz/1080p@50Hz/1080p@60Hz



OSD Setting

This menu allows you to set OSD Timeout and OSD Transparency .

This menu allows you to rename the favorite group.

OSD Timeout: 1-10

OSD Transparency:  To set the OSD transparency to Off/10%/20%/30%/
40%.

SYSTEM SETUP

Parental Lock

In "System Setup" menu, select "Parental Lock" and press "OK" button,
you are asked to input a password(the default password is"0000").
After inputting the correct password by pressing numeric buttons, 
the parental lock menu appears.

1

2

Menu Lock:  

New Password:  To change the password.

Confirm Password:  To confirm the new password.

Rating Lock: Off/ AGE 4/AGE5/AGE6/AGE7/AGE8/AGE9/AGE10/AGE11/AGE12/
AGE13/AGE14/AGE15/AGE16/AGE17/AGE18
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To lock the Edit channel/ Installation menu. When you  
want to enter these menus, you must input the password. 
You can set menu lock to on/off.

This menu allows you to protect  menu and channel, and change the 
Password.

Favorite

In Channel menu, select "Favorite", press "OK" button to enter 
Favorite menu.
Select desired group, press "OK" button to open the mock keypad.
Input letter and numeric one by one by pressing the cursor button 
and press "OK" button to confirm. After finishing input, highlight 
"OK" on mock keypad to confirm, you change Favorite group name 
successfully.
Press "EXIT" button to quit the group rename menu.

1
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Menu Lock
Rating Lock
New Password
Confirm Password

Off
Off
----
----

Parental Lock

OSD Timeout
OSD Transparency

5
Off

OSD Setting

1
2
3
4
5
6
7
8 

Favorite

Fav group 1
Fav group 2
Fav group 3
Fav group 4
Fav group 5
Fav group 6
Fav group 7
Fav group 8

CAPS

A

Fav group 1 

G
M

S

Y

4

SP

Rename

Del OK

B C D E F
K LH JI

N

T

Z

5

O

U

0

6

?

P

V

1

7
<-

Q

W

2

8

OK

R

X

3

9

Timer Setting

This menu  allows us to set the program timer. You can set 8 timers.

Timer Mode:
Timer Service:
Wakeup Channel:
Wakeup Date:
On Time:
Duration: 

Off/Once/Daily/Weekly/Monthly
Channel/Record
You can select a desired channel as the wakeup channel.
Press numeric button to input date.
Press numeric button to input the time.
Press numeric button to input the duration time.

Save Cancel

Current Time/date: 01:36PM   xx/xx/xxxx

Timer Mode
Timer Service
Wakeup Channel
Wakeup Date
On Time 
Duration

Daily
Channel

BBC FOUR
xx/xx/xxxx

xx:xx
xx:xx 



Other

No command to STB on front panel or Remoter in 30 Min- 3 hours and no timer event, 
the STB will enter standby mode automatically.

If Off is selected, the STB can't enter standby mode automatically.

LNB Power 
Channel Play Type 
Beeper 
Auto Standby

Off 
All 
Off 
Off

Other

SYSTEM SETUP

Auto Description Setting

On/Off 

On/Off 

-3~3

AD Service: 

Use AD as default: 

AD Volume Offset:

AD Service 
Use AD as default 
AD Volume Offset

On 
Off 
0

Auto Description Setting

LNB Power:

Channel Play Type:

Beeper:

Auto Standby:

This menu allows us to set LNB Power, Channel Play Type, Beeper and 
Auto Standby.

When "LNB Power" is selected "On", the STB will provide 5V power 
to antenna.
It will not provide when selected "Off".     

On/Off 

All/Free/Scrambled

On/Off 

30Min/1 Hour/2 Hour/3 Hour/Off

This menu allows us to set AD Service, Use AD as default and 
AD Volume Offset:
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 Multiview Setting

Multiview Setting  4+1Pictures

Multiview Setting

Multiview Setting: 4+1 Pictures/3x3 Pictures 

This menu allows us to set Multiview

In "System Setup" menu, select "Multiview Setting" and press "OK"
 button, you can select your desired item4+1Picturesor 3x3 Pictures .
After you select your desired item, press "EXIT" button to exit the main
menu,then press "BLUE" button to enter multiview.

1

2

Channel 1

Channel 4

Channel 7

Channel 5 Channel 6

Channel 8 Channel 9

Channel 2 Channel 3

Channel1

Channel 4

Channel 5

Channel 1

Channel 2

Channel3

4+1 Pictures 3x3 Pictures 



Tools main menu 

Information 

In "Tools" menu, select "Information", press "OK" button to open 
information window.

Press "EXIT" button to exit.
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                 TOOLS

This menu can display some parameters  information in this STB.

Factory Setting

This menu allows you to re-set the STB back to factory settings, 
clear all existed channels.

In the "Tools" menu, select "Factory Default", press "OK" button. 
You are asked to input a password(the default password is"0000").

1

2 A confirmation window is displayed.
Select "Yes" to return back to factory settings  and clear all channels.
Select "No" to cancel back to factory settings.
Press "EXIT" button to exit .

4

1

2

3

Press the "MENU" button to enter main menu.

Press "UP" or " DOWN " button to highlight "Tools", press "RIGHT" 

button to enter the Tools menu.

Press "UP" or "DOWN" cursor button  to highlight the desired item 

and press "OK" button to enter the sub-menu.

Press "EXIT" button to exit.

3

Tools
Information
Factory Setting
Upgrade By USB
Remove USB device safely

Information
x.x.x
xxxxx
xxxxx
x.x.x
x.x.x

xxx
xxxxx
xxxxx
xxx
xxx

Factory Setting

This operation will load default and erase all
the channels that user added, continue?

Yes No

Remove USB device safely

In "Tools" menu, select "Remove USB device safely", 
Press "OK" button to confirm. Then a window is displayed.
Press "OK" button again.

Disk Remove
Remove

OK

USB Disk A-3 GB

Cancel
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Software Upgrade

Press "EXIT" button to exit.

Enter "Tools" menu, select "Upgrade by USB", press "OK" button, 
Software Upgrade menu is shown.

1

2 Press cursor button to select the desired item, then highlight 
"Start" and press "OK" button to start upgrade.

3

We offer the functions for user to upgrade software by USB . Upgrade by USB

Upgrade Mode
Upgrade File
Start

Allcode
No File

0%



REC main menu

RECORDING
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4
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Press the "MENU" button to enter main menu.

Press "UP"or "DOWN" button to highlight "REC", press 

"RIGHT" button to enter the REC menu.

Press "UP" or "DOWN" cursor button to highlight the desired item 

and press "OK"button to enter the sub-menu.

Press "EXIT" button to exit.

Media Player

3

In "REC" menu, select "Media Player", press "OK" button to enter 
Media Player menu.
First you enter media player window, the highlight is on the 
USB/HDD device. Press "Down" button  to move the highlight to 
directory and file field. 
Press "1" button ,you can switch TAB between 
Music/Image/Video/Record.
Press "UP" or "DOWN" cursor button to select a desired item, 
and press "OK" button to play the desired files. 
Press "EXIT" button to exit.

1

2

This function allows you to play files from USB port .     

REC
Media Player
PVR Storage Information
PVR Setting

Music:

Image:    

 Press  "RED" button to show Play List. 
 Move the highlight to the file which you want to add to play list, then press 
"Green" button to add. It will mark a favorite icon  on the file.
Press "Yellow" button to add all file of current directory to play list. Press  again to 
delete all file of current directory from the play list.
Press "Blue" button to enter to edit sub-menu.
Press "2" button to open the sort window. 
You can sort by Name/Time/Size/Favorite.
Press "INFO" button to set repeat mode. The option is Repeat Folder/ 
Random Folder/Repeat One.
Return to parent directory.

4

5

Press "Red" button to show play list.
Move the highlight to the file which you want to add to play list, then press 
"Green" button to add. It will mark a favorite icon on the file.
Press "Yellow" button to add all file of current directory to play list. Press  again to 
delete all file of current directory from the play list. 
Press "Blue" button to enter to edit sub-menu. 
Press "2" button to open the sort window. 
You can sort by Name/Time/Size/Favorite.
Press "INFO" button to open image setup
Press "3" button to view image in 
multi view mode
Return to parent directory.

"RED" button: 
"GREEN" button:
 
"YELLOW" button: 

"BLUE" button: 
"2" button:
 
"INFO" button: 

"EXIT" button:

"RED" button: 
"GREEN" button:
 
"YELLOW" button: 

"BLUE" button:  
"2" button: 

"INFO" button: 
"3" button: 
"EXIT" button:

I swear.mp3
3319KB
00:03:32

00:03:15  00:03:32

1
2
3
4
5
6
7

Music

840.mpg
I swear.mp3
Why.mp3
Lonely.mp3
Because.mp3
Rose.jpg
Fly.jpg 

USB 1

/..

Play List

Switch Repeat Sort

MPG
MP3
MP3
MP3
MP3
JPG
JPG

INFO

21

FAV FAV All Edit

ExitEXIT

Image Video Record

i

 NOTE:                  When you browse pictures ,  
press "RED" button or "GREEN" button, 
you can view 3D pictures.  



This menu allows us to set the PVR Setting.

Press "UP" or "DOWN" cursor button to select desired item, 
press "LEFT" or "RIGHT" cursor button to change the setting.

TimeShift                                AUTO/Pause/Off

Timeshift to Record              On/Off

PS Record                              On/Off 

PVR Setting
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REC

PVR Storage Information

In "REC" menu, select "HDD Information", press "OK" 
button to open HDD information window.

Press "EXIT" button to exit.

This menu can display some parameters of Removable Disk.

1

2

PVR Storage Information
USB Disk A: xxxG bytes

Volume
Total Size
Free Size
Rec Size
TMS Size
File System

xxxx
xxxx
xxxx
xxxx
xxxx

xxx

Format DVR Set

Timeshift
Timeshift to Record
PS Record

Pause 
Off 
Off

PVR Setting

DVR Set                 REC & TMS/Record/Timeshift

Press BLUE button to open DVR Set menu. 
Press "LEFT" or "RIGHT" cursor button to change DVR Type.
Select "OK" to confirm. Select "Cancel" to cancel.

Press YELLOW button to open Format menu.
Press "LEFT" or "RIGHT" cursor button to change Disk Mode.
Select "OK" to format. Select "Cancel" to cancel.

Format  FAT/NTFS

DVR Set
DVR Type

OK

REC& TMS

Cancel

Format
Disk Mode

OK

FAT

Cancel

Record:

Press "Red" button to  open rename window. 
Move the highlight to the program which you want to lock. Pressing "Green" 
button, it will ask you to input password. Default password is "0000". After 
input correct password, the program  is locked. If you want to unlock the 
program, press the "Green" button again.
Press "Yellow" button to make a delete mark on the program which 
you want to delete.
Return to parent directory.

Video:

Press "Blue" button to enter to edit sub-menu.
Press "2" button  to open the sort. You can sort by Name/Time/Size.
Return to parent directory.

"BLUE" button:  
"2" button: 
"EXIT" button:

"RED" button: 
"GREEN" button:
 

"YELLOW" button: 

"EXIT" button:



TIMESHIFT/RECORDING

TimeShift

Plugging an external Mass Storage Device on the USB port gives you access to Time Shift/Record 
a broadcasted programme.

Pause a broadcast programme  and continue watching it later (TimeShift )
Record a broadcasted programm
When the space available on the Mass Storage Device runs out, recording operation of 
broadcasting will stop.

Initiate

Trickmodes

Stop the TimeShift

TimeShift can be done in viewing mode by pressing the  
"PAUSE" button.
Press "RIGHT" or "LEFT" button to move the cursor to
the time you desired to view. Press "OK" button to confirm.

During the playback, it is possible to perform the following actions :
Press "PAUSE" button to pause the playback
Press "FORWARD" button to fast forward the playback
Press "BACKWARD" button to rewind the playback

Recording

Instant record

In viewing mode, press "RECORD" button to instantaneously start a record on the current channel.
Press "RECORD" button again can input duration.
Press "STOP" button to stop recording, then a confirmation window appears. 
Select "Yes" to stop recording. Select "No" to continue recording.

Press "STOP" button to stop TimeShift.

BBC FOUR

Play    00:02:37 00:07:12

TS

2%

03/19 01:36
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NOTE:

Please use USB 2.0 disk when recording or TimeShift.
For TimeShift and recording feature, you need take bigger size USB flash
drive or HDD (>2GB) for recording.

Please select famous brand USB 2.0 USB HDD or USB stick for Recording and Timeshift, such as SAMSUNG, 
HITACHI  and SONY. Some USB devices maybe can't be supported due to its quality.

NOTE:



In some region, the digital terrestrial signal may be weak. So you'd better use the antenna in 
which the booster was built, for watching the weak signal channels.

TROUBLESHOOTING

Problem

Standby light not lit

No signal found

No picture or sound

Scrambled channel 
message

No response to remote 
control

Forgotten channel lock 
code

Forgotten menu lock 
code

The remote control will 
not operate your STB

After moving the STB to 
another room you find you 
are no longer able to
receive digital reception 

Possible cause What to do

Mains lead unplugged 
Mains fuse blown

Aerial is disconnected 
Aerial is damaged/misaligned
Out of digital signal area

Scart/AV is not selected on your TV

Channel is scrambled 

Receiver off
Handset not aimed correctly
Front panel obstructed 
Hand set batteries exhausted

(1) The batteries in your remote 
     control need replacing 
(2) There is an obstruction 
     blocking the signal path 
     between the remote control
     and the box. 

The aerial feed former new point
may come through a distribution 
system which may reduce the 
digital signal now received by the
box.

Check mains lead 
Check fuse 

Check aerial lead
Check aerial 
Check with dealer 

Reduce to another channel 

Select alternative channel

Plug in and turn on plug
Aim handset at front panel 
Check for obstructions
Replace handset batteries 

Re-install channels to cancel 
channel lock 

Contact help line

(1) Replace the batteries 
(2) Check that there is nothing in 
      the way of the path between
      the remote control and the 
      receiver

Try a direct feed from the antenna 
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TUNER & CHANNEL RF INPUT CONNECTOR x1
(IEC-TYPE, IEC169-2, FEMALE)
RF OUTPUT CONNECTOR x1
(IEC-TYPE, IEC169-2, MALE (LOOPTHROUGH)

FREQUENCY RANGE:
174MHz~230MHz(VHF)
470MHz ~862MHz (UHF)

SIGNAL LEVEL: 
-15 ~ -70 dbm

DECODER

Video decoder

Audio decoder

VIDEO FORMATS                    

MODULATION

                       

VIDEO OUTPUT                      

INPUT RATE                                                 MAX. 48Mbit/s

                    4:3/,16:9 SWITCHABLE

HDMI, SCART

QPSK,16QAM,64QAM

CONNECTION
MAIN POWER CABLE 

TUNER

SCART  

SPDIF

FIXED TYPE

ANTENNA INPUTx1, RF OUTPUT x1 

COAXIAL x1

POWER SUPPLY

INPUT VOLTAGE 220-240V~, 50/60Hz

TO TV x1
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MPEG-2 MP@HL, AVC/H.264 HP @L4.1
MPEG-4 ASP SUPPORTED

MPEG-1 Layer 1,2/PCM/HE-AAC V1.0
ICE958 SPDIF/DOBLY D+/DOBLY D

SPECIFICATIONS

Design and specifications are subject to change without notice.NOTE:

HDMI HDMI OUTPUT x1

DATA PORT  USB slot

ANALOG AUDIO OUTPUT Down Mix Stereo output (Left and Right) x1

Manufactured under license from Dolby Laboratories. Dolby and 
the double-D symbol are trademarks of Dolby Laboratories.

DECLARATION OF CONFORMITY
Hereby, the company ABACUS Electric s. r. o. declares that EVOLVEO Alpha HD 
(EAN: 8594161332930) is in compliance with the requirements of the norms and regulations, 
relevant for the given type of device. 
The complete text of Declaration of Conformity can be found on ftp://ftp.evolveo.com/ce

Copyright © Abacus Electric s.r.o.
www.evolveo.com

All rights reserved. 
Design and specification can be changed without prior notice.
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